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Overview
LevelOne’s FCS-4020 is a high performance speed dome network camera integrated with a SONY 35x
zoom lens and Exview HAD CCD sensor. With its powerful zoom capability, this camera offers close-up
images of distant objects in sharp detail. It is designed for professional outdoor surveillance applications
where high reliability, sharp images, and weatherproofing (IP66 rated) are required.
Along with the high sensitivity SONY Exview HAD CCD sensor and incorporating a removable IR-cut
filter, the FCS-4020 is capable of detection at near infrared light region with great proficiency, drastically
improving light efficiency, especially during nighttime. The WDR function enables the FCS-4020 to
generate identifiable images, overcoming the difficulties of challenging lighting conditions.
Featuring EIS (Electronic Image Stabilizer), the FCS-4020 can mitigate the influence of vibration caused
by winds or camera rotation so as to ensure stable and recognizable image quality at all times. The 3D
privacy mask function guarantees that private areas are completely sheltered even when the camera
pans, tilts, and zooms. When zooming in, the privacy mask will be enlarged to provide comprehensive
blockage of the private area. In addition, the FCS-4020 incorporates an SD/SDHC card slot so as to offer
temporary on-board recording.
Similar to the advanced features of LevelOne other cameras, the FCS-4020 includes, 3GPP mobile
surveillance, dual-codec, dual-stream, two-way audio via SIP protocol, digital I/O, 802.1X authentication
for network protection, and USB joystick for remote PTZ control. With the LevelOne FCS-4020, these
exceptional features provide efficient operational flexibility to meet customers’ needs in versatile
surveillance applications both outdoors and indoors.

Read Before Use

The use of surveillance devices may be prohibited by law in your country. The Network Camera is not
only a high-performance web-ready camera but can also be part of a flexible surveillance system. It is
the user’s responsibility to ensure that the operation of such devices is legal and complies with all privacy
laws before installing this unit for its intended use.
It is important to first verify that all contents received are complete according to the Package Contents
listed below. Take note of the warnings in the Quick Installation Guide before the Network Camera is
installed; then carefully read and follow the instructions in the Installation chapter to avoid damage due to
faulty assembly and installation. This also ensures the product is used properly as intended.
The Network Camera is a network device and its use should be straightforward for those who have basic
networking knowledge. It is designed for various applications including video sharing, general security/
surveillance, etc. The Configuration chapter suggests ways to best utilize the Network Camera and
ensure proper operations. For more creative and professional developers, the URL Commands of the
Network Camera section serves as a helpful reference to customizing existing homepages or integrating
with the current web server.

Package Contents

■ FCS-4020
■ Black Cover / Dome Cover
■ Power Adapter
■ Wall Mount Bracket
■ O-ring and Screws / Alignment Sticker
■ Silica Gel / Metal Ring
■ RJ45 Female/female Coupler
■ Quick Installation Guide
■ CD Manual / Utility
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Physical Description
Inner View

SD/SDHC Card Slot
Status LED
Reset Button

Lens

Outer View

General I/O
Terminal Block
Ethernet 10/100
RJ45 Plug
Audio Out (green)
Microphone In (pink)
Power Cord Socket (black)
Ground
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General I/O Terminal Block
This Network Camera provides a general I/O terminal block which is used to connect external
input / output devices. The pin definitions are described below.
GND: Ground
D I 4 : Digital Input
D I 3 : Digital Input
D I 2 : Digital Input
D I 1 : Digital Input
GND: Ground
N.O. : RELAY_NO
COM.: RELAY_COM
+12V : Power, 12V DC

Pin
GND
DI4
DI3
DI2
DI1
GND
N.O.
COM.
+12V

Name
Ground
Digital Input
Digital Input
Digital Input
Digital Input
Ground
Relay_NO
Relay_COM
Power +12V

Specification

Remarks

OPEN/Short-to-GND, isolation 2KV
OPEN/Short-to-GND, isolation 2KV
OPEN/Short-to-GND, isolation 2KV
OPEN/Short-to-GND, isolation 2KV

Internal pull-up
Internal pull-up
Internal pull-up
Internal pull-up

Normal Open pin, Max 30VDC, 1A
Common Pin , Max 30VDC, 1A
12VDC ± 10%, max. 0.8A

Max. rating 1.2A

DI/DO Diagram
Please refer to the following illustration for the connection method.
Digital Input

Digital Output
+12V

+12V
Power+12V

Relay_NO
Digital input

Ground

Relay_COM

Ground
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Hardware Reset

Reset Button

The reset button is used to reset the system or restore the factory default settings. Sometimes
resetting the system can return the camera to normal operation. If the system problems remain
after rebooting, restore the factory settings and install again.
Reset: Press and release the reset button with a paper clip or thin object. Wait for the Network
Camera to reboot.
Restore: Press and hold the reset button until the status LED rapidly blinks red and green
simultaneously. Note that all settings will be restored to factory default.

SD Card Capacity
This network camera is compliant with SD/SDHC 16GB / 8GB and other preceding standard SD
cards.

Status LED
The color of LED indicates the status of the Network Camera.
Item
1
2
3
4
5

LED status
Steady Red
Red LED unlighted
Steady Red + Blink Green every 1 sec.
Steady Red + Green LED unlighted
Steady Red + Blink Green every 2 sec.
Blink Red every 0.15 sec. + Blink Green every 1 sec.
Blink Red every 0.15 sec. + Blink Green every 0.15 sec.

6 - User Manual

Description
Power on and system booting
Power off
Network works (heartbeat)
Network fail
Audio mute (heartbeat)
Upgrading Firmware
Restore default

LevelOne

Installation

Hardware Installation
1. Attach the alignment sticker to the wall.
2. Drill four pilot holes into the wall.
3. Attach the black cover to the Network Camera using the four supplied black screws.
4. Stick the two pieces of supplied silica gel symmetrically to the inner side of the dome cover.
Then place the metal ring into the dome cover to fix the silica gel.
5. Fix the dome cover to the Network Camera and secure it by rotating it clockwise.
6. Loosen the three screws on the front opening of the wall mount bracket.
7. Place the O-ring on the front opening of the wall mount bracket.
8. Feed the cables through the front opening of the wall mount bracket and pull them from wall
outlet.
9. Attach the Network Camera to the wall mount bracket by tightening the three screws on the
front opening of the wall mount bracket.
10. Fasten the wall mount bracket to the wall.
10
1

7

8

2
3

5

9

6

4
Silica gel
Silica gel
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Network Deployment
Setting up the Network Camera over the Internet
This section explains how to configure the Network Camera over an Internet connection.
1. If you have external devices such as sensors and alarms, connect them to the general I/O
terminal block.
2. Use the supplied RJ45 female/female coupler to connect the Network Camera to a switch.
Use a Category 5 Cross Cable when Network Camera is directly connected to PC.
3. Connect the power cable from the Network Camera to a power outlet.
1
POWER

1

COLLISION

1

2

3

4

5

LINK
RECEIVE
PARTITION

Ethernet Switch

2

GND: Ground
D I 4 : Digital Input
D I 3 : Digital Input
D I 2 : Digital Input
D I 1 : Digital Input
GND: Ground
N.O. : RELAY_NO
COM. : RELAY_COM
+12V : Power, 12V DC

3

There are several ways to set up the Network Camera over the Internet. The first way is to set
up the Network Camera behind a router. The second way is to utilize a static IP. The third way is
to use PPPoE.
Internet connection via a router
Before setting up the Network Camera over the Internet, make sure you have a router and follow
the steps below.
1. Connect your Network Camera behind a router, the Internet environment is illustrated below.
Regarding how to obtain your IP address, please refer to Software Installation on page 10 for
details.

WAN (Wide Area Network )

Internet

Router IP address : from ISP
POWER

COLLISION

1

2

3

4

5

IP address : 192.168.0.3
Subnet mask : 255.255.255.0
Default router : 192.168.0.1

LINK
RECEIVE
PARTITION

LAN (Local Area Network)
Router IP address : 192.168.0.1
Cable or DSL Modem

IP address : 192.168.0.2
Subnet mask : 255.255.255.0
Default router : 192.168.0.1
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2. In this case, if the Local Area Network (LAN) IP address of your Network Camera is
192.168.0.3, please forward the following ports for the Network Camera on the router.
■ HTTP port
■ RTSP port
■ RTP port for audio
■ RTCP port for audio
■ RTP port for video
■ RTCP port for video
If you have changed the port numbers on the Network page, please open the ports accordingly
on your router. For information on how to forward ports on the router, please refer to your
router’s user’s manual.
3. Find out the public IP address of your router provided by your ISP (Internet Service Provider).
Use the public IP and the secondary HTTP port to access the Network Camera from the
Internet. Please refer to Network Type on page 33 for details.
Internet connection with static IP
Choose this connection type if you are required to use a static IP for the Network Camera.
Please refer to LAN on page 33 for details.
Internet connection via PPPoE (Point-to-Point over Ethernet)
Choose this connection type if you are connected to the Internet via a DSL Line. Please refer to
PPPoE on page 34 for details.
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Software Installation
Installation Wizard (IW) , free-bundled software included on the product CD, helps you set up
your Network Camera on the LAN.
1. Install IW from the Software Utility directory on the software CD.
Double click the IW shortcut on your desktop to launch the program.
2. The program will search for all LevelOne network devices on the same LAN.
3. After searching, the main installer window will pop up. Click on the MAC and model name
which matches the product label on your device to connect to the Network Camera via
Internet Explorer.

FCS-4020

H/W Ver:1.0

S/N:YYMMDDXXXXX
MAC:00116B80F13E
00-11-6B-80-F1-3E

192.168.3.143

Power : AC24V/2A
This device complies with part 15 of the FCC Rules. Operation is subject to
the following two conditions:
(1) this device may not cause harmful interference, and
(2) this device must accept any interference received, including interference
that may cause undesired operation.
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Ready to Use
1. Access to the Network Camera from the Internet.
2. Retrieve live video through a web browser or recording software.
Please refer to page 12 for detailed information.
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Accessing the Network Camera
This chapter explains how to access the Network Camera through web browsers, RTSP players,
3GPP-compatible mobile devices, and the LevelOne recording software.

Using Web Browsers
Use Installation Wizard 2 (IW2) to access to the Network Cameras installed on the LAN.
If your network environment is not the LAN, follow these steps to access the Network Camera:
1. Launch your web browser (eg. Microsoft® Internet Explorer, Mozilla Firefox, or Netscape).
2. Enter the IP address of the Network Camera in the address field. Press Enter.
3. The live video will be displayed in your web browser.
4. If this is the first time installing the LevelOne network camera, an information bar will pop up
as shown below. Follow the instructions to install the required plug-in on your computer.

NOTE
► For Mozilla Firefox or Netscape users, your browser will use Quick Time to stream the live
video. If you do not have Quick Time on your computer, please install it first, then launch the
web browser.
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► By default, the Network Camera is not password-protected. To prevent unauthorized access,
it is highly recommended to set a password for the Network Camera.
For more information about how to enable password protection, please refer to Security on
page 26.
► If you see a dialog box indicating that your security settings prohibit running ActiveX ®
Controls, please enable the ActiveX ® Controls for your browser.
1. Choose Tools > Internet Options > Security > Custom Level.

2. Look for Download signed ActiveX ® controls; select Enable or Prompt. Click OK.

3. Refresh your web browser, then install the Active X ® control. Follow the instructions to
complete installation.
User Manual - 13
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Using RTSP Players
To view the MPEG-4 streaming media using RTSP players, you can use one of the following
applications that support RTSP streaming.
Quick Time Player
Real Player
VLC media player
1. Launch the RTSP player.
mpegable
Player
2. Choose
File > Open
URL. A URL dialog box will pop up.
3. The address format is rtsp://<ip address>:<rtsp port>/<RTSP streaming access name for
pvPlayer
stream1 or stream2>
As most ISPs and players only allow RTSP streaming through port number 554, please set the
RTSP port to 554. For more information, please refer to RTSP Streaming on page 46.
For example:
rtsp://192.168.5.151:554/live.sdp

4. The live video will be displayed in your player.
For more information on how to configure the RTSP access name, please refer to RTSP
Streaming on page 46 for more details.
Video 16:38:01 2008/01/03
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Using 3GPP-compatible Mobile Devices
To view the streaming media through 3GPP-compatible mobile devices, make sure the Network
Camera can be accessed over the Internet. For more information on how to set up the Network
Camera over the Internet, please refer to Setup the Network Camera over the Internet on page 8.
To utilize this feature, please check the following settings on your Network Camera:
1. Because most players on 3GPP mobile phones do not support RTSP authentication, make
sure the authentication mode of RTSP streaming is set to disable.
For more information, please refer to RTSP Streaming on page 46.
2. As the the bandwidth on 3G networks is limited, larger video sizes are not available. Please
set the video and audio streaming parameters as listed below.
For more information, please refer to Audio and Video on page 52.
Video Mode
Frame size
Maximum frame rate
Intra frame period
Video quality (Constant bit rate)
Audio type (GSM-AMR)

MPEG-4
176 x 144
5 fps
1S
40kbps
12.2kbps

3. As most ISPs and players only allow RTSP streaming through port number 554, please set
the RTSP port to 554. For more information, please refer to RTSP Streaming on page 46.
4. Launch the player on the 3GPP-compatible mobile device (ex. Real Player).
5. Type the following URL commands in the player.
The address format is rtsp://<public ip address of your camera>:<rtsp port>/<RTSP streaming
access name for stream1 or stream2>.
For example:

rtsp://192.168.5.151:554/live.sdp
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Using LevelOne Recording Software
The product software CD also contains LevelOne recording software, allowing simultaneous
monitoring and video recording for multiple Network Cameras. Please install the recording
software, then launch the program to add the Network Camera to the Channel list. For detailed
information about how to use the recording software, please refer to the user’s manual of the
software or download the manual from http://www.level1.com.
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Main Page
This chapter explains the layout of the main page. It is composed of the following sections:
LevelOne INC. Logo, Host Name, Camera Control Area, PTZ Control Panel, Configuration Area,
and Live video window.
LevelOne INC. Logo

Host Name

Camera Control Area

PTZ Control Panel

Live View Window

Configuration Area

LevelOne INC. Logo
Click this logo to visit the LevelOne website.

Host Name

The host name can be customized to fit your needs. For more information, please refer to System on page
24.

Camera Control Area
Video Stream: This Network Camera supports MJPEG or MPEG-4 dual streams simultaneously. You can
select either one for live viewing.
Digital Output: Click to turn the digital output device on or off.

PTZ Control Panel
Left

Up
Return to Home Position
Right

Down
Zoom Out
Focus Near

Zoom In
Focus Far

Auto Focus

Start to Auto Patrol

Start to Auto Pan
Stop Auto Panning/patrolling
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Pan: Click this button to start the auto pan (360° continuous rotation).
Stop: Click this button to stop the Auto Pan and Auto Patrol functions.
Patrol: Once the Administrator has determined the list of preset positions, click this button to command
the camera to patrol among those positions on the Patrol List. The Network Camera will patrol
continuously. For more information, please refer to Camera Control on page 64
Pan /Tilt /Zoom /Focus speed: Adjust the speed of Pan/ Tilt/ Zoom/ Focus:
Pan speed
-5
-4
-3
-2
-1
0
1
2
3
4
5

Tilt speed
-5
-4
-3
-2
-1
0
1
2
3
4
5

Zoom speed
-5
-4
-3
-2
-1
0
1
2
3
4
5

Focus speed
-5
-4
-3
-2
-1
0
1
2
3
4
5

Slower

Faster

Configuration Area

Client Settings: Click this button to access the client settings page. For more information, please refer to
Client Settings on page 21.
Configuration: Click this button to access the configuration page of the Network Camera. It is suggested
that a password be applied to the Network Camera so that only the administrator can configure the
Network Camera. For more information, please refer to Configuration on page 23.
Language: Click this button to choose a language for the user interface. Language options are available
in: English, Deutsch, Español, Français, Italiano, 日本語, Português, 簡体中文, and 繁體中文.

Live Video Window
■ The following window is displayed when the video mode is set to MPEG-4:
MPEG-4 Protocol and Media Options
Video Title
Title and Time

Time
Video 10:23:18 2009/02/11

Video and Audio Control Buttons Drop-down List of Preset Positions
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Video Title: The video title can be configured. For more information, please refer to Video Settings on
page 52.
MPEG-4 Protocol and Media Options: The transmission protocol and media options for MPEG-4 video
streaming. For further configuration, please refer to Client Settings on page 21.
Time: Display the current time. For further configuration, please refer to Video Settings on page 52.
Title and Time: The video title and time can be stamped on the streaming video. For further configuration,
please refer to Video Settings on page 52.
Video and Audio Control Buttons: Depending on the Network Camera model and Network Camera
configuration, some buttons may not be available.
Snapshot: Click this button to capture and save still images. The captured images will be displayed
in a pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP
(*.bmp) format.
Digital Zoom: Click and uncheck “Disable digital zoom” to enable the zoom operation. The navigation
screen indicates the part of the image being magnified. To control the zoom level, drag the slider bar. To
move to a different area you want to magnify, drag the navigation screen image.

Pause: Pause the transmission of the streaming media. The button becomes the
after clicking the Pause button.
Stop: Stop the transmission of the streaming media. Click the
transmission.

Resume button

Resume button to continue

Start MP4 Recording: Click this button to record video clips in MP4 file format. Press the
Stop MP4 Recording button to end recording. When you exit the web browser, video recording stops
accordingly. To specify the storage destination and the file name, please refer to MP4 Saving Options on
page 22 for details.
Volume: If the
local computer.

Mute function is not activated, move the slider bar to adjust the volume on the

Mute: Turn off the volume on the local computer. The button becomes the
clicking the Mute button.

Audio On button after

Talk: Click this button to talk to people around the Network Camera. Audio will project from
again to end talking
the external speaker connected to the Network Camera. Click this button
transmission.
Mic Volume: When the
Mute function is not activated, move the slider bar to adjust the
microphone volume on the local computer.
Mute: Turn off the
Mic volume at local computer. The button becomes the
after clicking the Mute button.

Mic On button

Full Screen: Click this button to switch to full screen mode. Press the “Esc” key to switch back to normal
mode.
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Go to: Once the Administrator has determined the list of preset positions, you can aim the camera using
this command. For more information, please refer to Camera Control on page 64.

■ The following window is displayed when the video mode is set to MJPEG:
Video Title
Title and Time

Time
Video 10:11:50 2008/01/09

Video Control Buttons

Drop-down List of Preset Positions

Video Title: The video title can be configured. For more information, please refer to Video Settings on
page 52.
Time: Display the current time. For more information, please refer to Video Settings on page 52.
Title and Time: The video title and time can be stamped on the streaming video. For more information,
please refer to Video Settings on page 52.
Video and Audio Control Buttons: Depending on the Network Camera model and Network Camera
configuration, some buttons may not be available.
Snapshot: Click this button to capture and save still images. The captured images will be displayed
in a pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP
(*.bmp) format.
Digital Zoom: Click and uncheck “Disable digital zoom” to enable the zoom operation. The navigation
screen indicates the part of the image being magnified. To control the zoom level, drag the slider bar. To
move to a different area you want to magnify, drag the navigation screen image.

Start MP4 Recording: Click this button to record video clips in MP4 file format. Press the
Stop MP4 recording button to end recording. When you exit the web browser, video recording stops
accordingly. To specify the storage destination and file name, please refer to MP4 Saving Options on
page 22 for details.
Full Screen: Click this button to switch to full screen mode. Press the “Esc” key to switch back to normal
mode.
Go to: Once the Administrator has determined the list of preset positions; you can aim the camera using
this command. For more information, please refer to Camera Control on page 64.
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Client Settings
This chapter explains how to select the stream transmission mode and saving options on the
local computer. When finished with the settings on this page, click Save on the bottom of the
page to enable the settings.
MPEG-4 Media Options

Select whether to stream video or audio data or both. This is enabled only when the video mode is set to
MPEG-4.

MPEG-4 Protocol Options

Depending on your network environment, there are four transmission modes for MPEG-4 streaming:
UDP unicast: This protocol allows for better real-time audio and video streams. However, network
packets may be lost due to network burst traffic and images may be broken. Activate the UDP connection
when occasions require time-sensitive responses and the video quality is less important. Note that each
unicast client connecting to the server takes up additional bandwidth and the Network Camera allows up
to ten simultaneous accesses.
UDP multicast: This protocol allows multicast-enabled routers to forward network packets to all clients
requesting streaming media. This helps to reduce the network transmission load of the Network Camera
while serving multiple clients at the same time. Note that to utilize this feature, the Network Camera must
be configured to enable multicast streaming at the same time. For more information, please refer to
RTSP Streaming on page 46.
TCP: This protocol guarantees the complete delivery of streaming data and thus provides better video
quality. However, the real-time effect is not as good as that of the UDP protocol.
HTTP: This protocol allows for the same transmission quality as the TCP protocol without needing to
open specific ports for streaming under some network environments. Users inside a firewall can utilize
this protocol to allow streaming data through.
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MP4 Saving Options

Users can record live video as they are watching by clicking
Here, you can specify the storage destination and file name.

Start MP4 Recording on the main page.

Folder: Specify the storage destination for the recorded video files.
File name prefix: Enter the text that will be appended to the front of the video file name.
Add date and time suffix to the file name: Select this option to append the date and time to the end of the
file name.
CLIP_20080108-180853

File name preﬁx Date and time sufﬁx
The format is: YYYYMMDD_HHMMSS

22 - User Manual

LevelOne

Configuration
Click Configuration on the main page to enter the camera setting pages. Note that only
Administrators can access the configuration page.
LevelOne offers an easy-to-use user interface that helps you set up your network camera with
minimal effort. To simplify the setting procedure, two types of user interfaces are available:
Advanced Mode for professional users and Basic Mode for entry-level users. Some advanced
functions (HTTPS/ Access list/ Homepage layout/ Application/ Recording/ System log/ View
parameters) are not displayed in Basic Mode.
If you want to set up advanced functions, please click [Advanced Mode] on the bottom of the
configuration list to quickly switch to Advanced Mode.
In order to simplify the user interface, the detailed information will be hidden unless you click on
the function item. When you click on the first sub-item, the detailed information for the first subitem will be displayed; when you click on the second sub-item, the detailed information for the
second sub-item will be displayed and that of the first sub-item will be hidden.
The following is the interface of the Basic Mode and the Advanced Mode:
Basic Mode

Configuration List

Click to switch to Advanced Mode
Firmware Version
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Advanced Mode

Configuration list
Click to switch to Basic mode
Firmware Version

Each function on the configuration list will be explained in the following sections. Those functions that are
displayed only in Advanced Mode are marked with Advanced Mode . If you want to set up the advanced
functions, please click [Advanced Mode] on the bottom of the configuration list to quickly switch over.

System
This section explains how to configure the basic settings for the Network Camera, including
System, System Time, and DI/DO. When completed with the settings on this page, click Save at
the bottom of the page to enable the settings.
System

Host name: Enter the desired name for the Network Camera. The text will be displayed at the top of the
main page.
Turn off the LED indicators: If you do not want to let others know that the network camera is in operation,
you can select this option to turn off the LED indicators.
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System Time

Keep current date and time: Select this option to preserve the current date and time of the Network
Camera. The Network Camera’s internal real-time clock maintains the date and time even when the
system power is turned off.
Sync with computer time: Select this option to synchronize the date and time of the Network Camera with
the local computer. The read-only date and time of the PC is displayed when updated.
Manual: The administrator can enter the date and time manually. Note that the date and time format is
[yyyy/mm/dd] and [hh:mm:ss].
Automatic: The Network Time Protocol is a protocol which synchronizes computer clocks by periodically
querying an NTP Server.
NTP server: Assign the IP address or domain name of the time-server. Leaving the text box blank
connects the Network Camera to the default time servers.
Update interval: Select to update the time using the NTP server on an hourly, daily, weekly, or monthly
basis.
Time zone Advanced Mode : Select the appropriate time zone from the list. If you want to upload
Daylight Savings Time rules on the Maintenance page, please refer to Upload / Export Daylight Saving
Time Configuration File on page 93 for details.

DI and DO

Digital input: Select High or Low to define the normal status for the digital input. The Network Camera
will report the current status.
Digital output: Select Grounded or Open to define normal status for the digital output. The Network
Camera will show whether the trigger is activated or not.
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Security
This section explains how to enable password protection and create multiple accounts.
Root Password

The administrator account name is “root”, which is permanent and can not be deleted. If you want to add
more accounts in the Manage User column, please set a password for the “root” account first.
1. Type the password in both text boxes, then click Save to enable password protection.
2. A window will be prompted for authentication; type the correct user’s name and password in their
respective fields to access the Network Camera.

Manage Privilege Advanced Mode

Digital Output & PTZ control: You can modify the manage privilege of operators or viewers. Check or
uncheck the item, then click Save to enable the settings. If you give Viewers the privilege, Operators will
also have the ability to control the Network Camera through the main page. (Please refer to Main Page
on page 17.)
Allow anonymous viewing: If you check this item, any client can access the live stream without entering a
User ID and Password.

Manage User

Administrators can add up to 20 user accounts.
1. Input the new user’s name and password.
2. Select the privilege level for the new user account. Click Add to enable the setting.
Access rights are sorted by user privilege (Administrator, Operator, and Viewer). Only administrators
can access the Configuration page. Operators cannot access the Configuration page but can use the
URL Commands to get and set the value of parameters. For more information, please refer to URL
Commands of the Network Camera on page 96. Viewers access only the main page for live viewing.
Here you also can change a user’s access rights or delete user accounts.
1. Select an existing account to modify.
2. Make necessary changes and click Update or Delete to enable the setting.
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HTTPS (Hypertext Transfer Protocol over SSL)

Advanced Mode

This section explains how to enable authentication and encrypted communication over SSL
(Secure Socket Layer). It helps protect streaming data transmission over the Internet on higher
security level.
Enable HTTPS

Check this item to enable HTTPS communication, then select a connection option: "HTTP & HTTPS"
or "HTTPS only". Note that you have to create and install a certificate first in the second column before
clicking the Save button.

Create and Install Certificate Method
Before using HTTPS for communication with the Network Camera, a Certificate must be created first.
There are three ways to create and install a certificate:
Create self-signed certificate automatically
1. Select this option.
2. In the first column, check Enable HTTPS secure connection, then select a connection option: “HTTP
& HTTPS” or “HTTPS only”.
3. Click Save to generate a certificate.
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4. The Certificate Information will automatically de displayed in the third column as shown below. You can
click Property to view detailed information about the certificate.

5. Click Home to return to the main page. Change the address from “http://” to “https://“ in the address
bar and press Enter on your keyboard. Some Security Alert dialogs will pop up. Click OK or Yes to
enable HTTPS.

https://

https://192.168.5.151/index.html
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Create self-signed certificate manually
1. Select this option.
2. Click Create to open a Create Certificate page, then click Save to generate the certificate.

3. The Certificate Information will automatically be displayed in the third column as shown below. You
can click Property to see detailed information about the certificate.

Create certificate and install : Select this option if you want to create an official certificate issued by
a CA (Certificate Authority).
1. Select this option.
2. Click Create to open the Create Certificate page, then click Save to generate the certificate.
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3. If you see the following Information bar, click OK and click on the Information bar on the top of the
page to allow pop-ups.

4. The pop-up window shows an example of a certificate request.
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5. Look for a trusted certificate authority that issues digital certificates. Enroll the Network Camera. Wait
for the certificate authority to issue a SSL certificate; click Browse... to search for the issued certificate,
then click Upload in the second column.

NOTE
► How do I cancel the HTTPS settings?
1. Uncheck Enable HTTPS secure connection in the first column and click Save; a warning dialog will
pop up.
2. Click OK to disable HTTPS.

3. The webpage will redirect to a non-HTTPS page automatically.
► If you want to create and install other certificates, please remove the existing one. To remove the
signed certificate, uncheck Enable HTTPS secure connection in the first column and click Save.
Then click Remove to erase the certificate.

User Manual - 31

LevelOne

SNMP (Simple Network Management Protocol)

Advanced Mode

This section explains how to use the SNMP on the network camera. The Simple Network
Management Protocol is an application layer protocol that facilitates the exchange of
management information between network devices. It helps network administrators to remotely
manage network devices and find, solve network problems with ease.
■ The SNMP consists of the following three key components:
1. Manager: Network-management station (NMS), a server which executes applications that monitor and
control managed devices.
2. Agent: A network-management software module on a managed device which transfers the status of
managed devices to the NMS.
3. Managed device: A network node on a managed network. For example: routers, switches, bridges,
hubs, computer hosts, printers, IP telephones, network cameras, web server, and database.
Before configuring SNMP settings on the this page, please enable your NMS first.

SNMP Configuration
Enable SNMPv1, SNMPv2c
Select this option and enter the names of Read/Write community and Read Only community according to
your NMS settings.

Enable SNMPv3
This option contains cryptographic security, a higher security level, which allows you to set the
Authentication password and the Encryption password.
■ Security name: According to your NMS settings, choose Read/Write or Read Only and enter the
community name.
■ Authentication type: Select MD5 or SHA as the authentication method.
■ Authentication password: Enter the password for authenrication (at least 8 characters).
■ Encryption password: Enter a password for ecryption (at least 8 characters).
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Network
This section explains how to configure a wired network connection for the Network Camera.
Network Type

LAN

Select this option when the Network Camera is deployed on a local area network (LAN) and is intended
to be accessed by local computers. The default setting for the Network Type is LAN. Rememer to click
Save when you complete the Network setting.
Get IP address automatically: Select this option to obtain an available dynamic IP address assigned by
the DHCP server each time the camera is connected to the LAN.
Use fixed IP address: Select this option to manually assign a static IP address to the Network Camera.

1. You can make use of LevelOne Installation Wizard 2 on the software CD to easily set up the Network
Camera on LAN. Please refer to Software Installation on page 10 for details.
2. Enter the static IP, Subnet mask, Default router, and Primary DNS provided by your ISP.
Enable UPnP presentation: Select this option to enable UPnPTM presentation for your Network Camera
so that whenever a Network Camera is presented to the LAN, shortcuts of connected Network Cameras
will be listed in My Network Places. You can click the shortcut to link to the web browser. Currently,
UPnPTM is supported by Windows XP or later. Note that to utilize this feature, please make sure the
UPnPTM component is installed on your computer.
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Network Camera (192.168.5.151)

Enable UPnP port forwarding: To access the Network Camera from the Internet, select this option to
allow the Network Camera to open ports on the router automatically so that video streams can be sent
out from a LAN. To utilize of this feature, make sure that your router supports UPnPTM and it is activated.

PPPoE (Point-to-point over Ethernet)

Select this option to configure your Network Camera to make it accessible from anywhere as long as
there is an Internet connection. Note that to utilize this feature, it requires an account provided by your
ISP.
Follow the steps below to acquire your Network Camera’s public IP address.
1. Set up the Network Camera on the LAN.
2. Go to Home > Configuration > Application > Server Settings (please refer to Server Settings on page
76) to add a new email or FTP server.
3. Go to Configuration > Application > Media Settings (please refer to Media Settings on page 79). Select
System log so that you will receive the system log in TXT file format which contains the Network
Camera’s public IP address in your email or on the FTP server.
4. Go to Configuration > Network > Network Type. Select PPPoE and enter the user name and password
provided by your ISP. Click Save to enable the setting.

5. The Network Camera will reboot.
6. Disconnect the power to the Network Camera; remove it from the LAN environment.

NOTE
► If the default ports are already used by other devices connected to the same router, the Network
Camera will select other ports for the Network Camera.
► If UPnP TM is not supported by your router, you will see the following message:
Error: Router does not support UPnP port forwarding.
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► Steps to enable the UPnP TM user interface on your computer:
Note that you must log on to the computer as a system administrator to install the UPnP TM
components.
1. Go to Start, click Control Panel, then click Add or Remove Programs.

2. In the Add or Remove Programs dialog box, click Add/Remove Windows Components.

3. In the Windows Components Wizard dialog box, select Networking Services and click Details.
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4. In the Networking Services dialog box, select Universal Plug and Play and click OK.

5. Click Next in the following window.

6. Click Finish. UPnP TM is enabled.
► How does UPnP TM work?
UPnP TM networking technology provides automatic IP configuration and dynamic discovery of devices
added to a network. Services and capabilities offered by networked devices, such as printing and file
sharing, are available among each other without the need for cumbersome network configuration. In
the case of Network Cameras, you will see Network Camera shortcuts under My Network Places.
► Enabling UPnP port forwarding allows the Network Camera to open a secondary HTTP port on the
router-not HTTP port-meaning that you have to add the secondary HTTP port number to the Network
Camera’s public address in order to access the Network Camera from the Internet. For example,
when the HTTP port is set to 80 and the secondary HTTP port is set to 8080, refer to the list below for
the Network Camera’s IP address.
From the Internet
http://203.67.124.123:8080

In LAN
http://192.168.4.160 or
http://192.168.4.160:8080

► If the PPPoE settings are incorrectly configured or the Internet access is not working, restore the
Network Camera to factory default; please refer to Restore on page 92 for details. After the Network
Camera is reset to factory default, it will be accessible on the LAN.
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Enable IPv6

Select this option and click Save to enable IPv6 settings.
Please note that this only works if your network environment and hardware equipment support IPv6. The
browser should be Microsoft® Internet Explorer 6.5, Mozilla Firefox 3.0 or above.

When IPv6 is enabled, by default, the network camera will listen to router advertisements and be
assigned with a link-local IPv6 address accordingly.
IPv6 Information: Click this button to obtain the IPv6 information as shown below.

If your IPv6 settings are successful, the IPv6 address list will listed in the pop-up window. The IPv6
address will be displayed as follows:

Refers to Ethernet

Link-global IPv6 address/network mask
Link-local IPv6 address/network mask
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Please follow the steps below to link to an IPv6 address:
1. Open your web browser.
2. Enter the link-global or link-local IPv6 address in the address bar of your web browser.
3. The format should be:
http://[2001:0c08:2500:0002:0202:d1ff:fe04:65f4]/
IPv6 address

4. Press Enter on the keyboard or click Refresh button to refresh the webpage.
For example:

NOTE
► If you have a Secondary HTTP port (the default value is 8080), you can also link to the webpage in
the following address format: (Please refer to HTTP on page 43 for detailed information.)
http://[2001:0c08:2500:0002:0202:d1ff:fe04:65f4]/:8080
IPv6 address

Secondary HTTP port

► If you choose PPPoE as the Network Type, the [PPP0 address] will show up in the IPv6 information
column as below.

Manually setup the IP address: Select this option to manually set up IPv6 settings if your network
environment does not have DHCPv6 server and router advertisements-enabled routers.
If you check this item, the following blanks will be displayed for you to enter the corresponding
information:
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IEEE 802.1x Advanced Mode
Enable this function if your network environment uses IEEE 802.1x, which is a port-based network
access control. The network devices, intermediary switch/access point/hub, and RADIUS server must
support and enable 802.1x settings
The 802.1x standard is designed to enhance the security of local area networks, which provides
authentication to network devices (clients) attached to a network port (wired or wireless). If all certificates
between client and server are verified, a point-to-point connection will be enabled; if authentication fails,
access on that port will be prohibited. 802.1x utilizes an existing protocol, the Extensible Authentication
Protocol (EAP), to facilitate communication.

■ The components of a protected network with 802.1x authentication:

Supplicant
(Network Camera)

Authenticator
(Network Switch)

Authentication Server
(RADIUS Server)

1. Supplicant: A client end user (camera), which requests authentication.
2. Authenticator (an access point or a switch): A “go between” which restricts unauthorized end users
from communicating with the authentication server.

3. Authentication server (usually a RADIUS server): Checks the client certificate and decides whether to
accept the end user’s access request.

■ LevelOne Network Cameras support two types of EAP methods to perform authentication: EAP-PEAP
and EAP-TLS.

Please follow the steps below to enable 802.1x settings:
1. Before connecting the Network Camera to the protected network with 802.1x, please apply a digital
certificate from a Certificate Authority (ie. MIS of your company) which can be validated by a RADIUS
server.
2. Connect the Network Camera to a PC or notebook outside of the protected LAN. Open the
configuration page of the Network Camera as shown below. Select EAP-PEAP or EAP-TLS as the
EAP method. In the following blanks, enter your ID and password issued by the CA, then upload
related certificate(s).
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3. When all settings are complete, move the Network Camera to the protected LAN by connecting it to an
802.1x enabled switch. The devices will then start the authentication automatically.

NOTE
► The authentication process for 802.1x:
1. The Certificate Authority (CA) provides the required signed certificates to the Network Camera (the
supplicant) and the RADIUS Server (the authentication server).
2. A Network Camera requests access to the protected LAN using 802.1X via a switch (the authenticator).
The client offers its identity and client certificate, which is then forwarded by the switch to the RADIUS
Server, which uses an algorithm to authenticate the Network Camera and returns an acceptance or
rejection back to the switch.
3. The switch also forwards the RADIUS Server’s certificate to the Network Camera.
4. Assuming all certificates are validated, the switch then changes the Network Camera’s state to
authorized and is allowed access to the protected network via a pre-configured port.

1
Certificate

Certificate Authority
(CA)

1
Certificate

2

4
LevelOne
Network Camera

Network Switch

3

RADIUS Server

Protected LAN
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QoS (Quality of Service) Advanced Mode
Quality of Service refers to a resource reservation control mechanism, which guarantees a certain quality
to different services on the network. Quality of service guarantees are important if the network capacity
is insufficient, especially for real-time streaming multimedia applications. Quality can be defined as, for
instance, a maintained level of bit rate, low latency, no packet dropping, etc.
The following are the main benefits of a QoS-aware network:
■ The ability to prioritize traffic and guarantee a certain level of performance to the data flow.
■ The ability to control the amount of bandwidth each application may use, and thus provide higher
reliability and stability on the network.

Requirements for QoS

To utilize QoS in a network environment, the following requirements must be met:
■ All network switches and routers in the network must include support for QoS.
■ The network video devices used in the network must be QoS-enabled.

QoS models
CoS (the VLAN 802.1p model)

IEEE802.1p defines a QoS model at OSI Layer 2 (Data Link Layer), which is called CoS, Class of
Service. It adds a 3-bit value to the VLAN MAC header, which indicates prioritization from 0~7 (Eight
different classes of service are available). The priority is set up on the network switches, which then use
different queuing disciplines to forward the packets.
Below is the setting column for CoS. Enter the VLAN ID of your switch (0~4095) and choose the priority
for each application (0~7).

If you assign Video the highest level, the switch will handle video packets first.

NOTE
► The web browsing may fail if the CoS setting is incorrect.
► Class of Service technologies do not guarantee a level of service in terms of bandwidth and delivery
time; they offer a "best-effort." Users can think of CoS as "coarsely-grained" traffic control and QoS as
"finely-grained" traffic control.
► Though CoS is simple to manage, it lacks scalability and does not offer end-to-end quarantees since it
is based on L2 protocol.
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QoS/DSCP (the DiffServ model)

DSCP-ECN defines QoS at Layer 3 (Network Layer). The Differentiated Services (DiffServ) model is
based on packet marking and router queuing disciplines. The marking is done by adding a field to the
IP header, called the DSCP (Differentiated Services Codepoint). This is a 6-bit field that provides 64
different class IDs. It gives an indication of how a given packet is to be forwarded, known as the Per Hop
Behavior (PHB). The PHB describes a particular service level in terms of bandwidth, queueing theory,
and dropping (discarding the packet) decisions. Routers at each network node classify packets according
to their DSCP value and give them a particular forwarding treatment; for example, how much bandwidth
to reserve for it.
Below are the setting options of DSCP (DiffServ Codepoint). Specify the DSCP value for each application
(0~63).
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HTTP Advanced Mode
To utilize HTTP authentication, make sure that your have set a password for the Network Camera first;
please refer to Security on page 26 for details.

Authentication: Depending on your network security requirements, the Network Camera provides two
types of security settings for an HTTP transaction: basic and digest.
If basic authentication is selected, the password is sent in plain text format and there can be potential
risks of being intercepted. If digest authentication is selected, user credentials are encrypted using MD5
algorithm and thus provide better protection against unauthorized accesses.
HTTP port / Secondary HTTP port: By default, the HTTP port is set to 80 and the secondary HTTP port is
set to 8080. They can also be assigned to another port number between 1025 and 65535. If the ports are
incorrectly assigned, the following warning messages will be displayed:

To access the Network Camera on the LAN, both the HTTP port and secondary HTTP port can be used
to access the Network Camera. For example, when the HTTP port is set to 80 and the secondary HTTP
port is set to 8080, refer to the list below for the Network Camera’s IP address.
In LAN
http://192.168.4.160 or
http://192.168.4.160:8080

Access name for stream 1 / Access name for stream 2: The access name is used to differentiate the
streaming source.
When using Mozilla Firefox or Netscape to access the Network Camera and the video mode is set to
JPEG, users will receive video comprised of continuous JPEG images. This technology, known as “server
push”, allows the Network Camera to feed live pictures to Mozilla Firefox and Netscape.
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URL command -- http://<ip address>:<http port>/<access name for stream1 or stream2>
For example, when the Access name for stream 2 is set to video2.mjpg:
1. Launch Mozilla Firefox or Netscape.
2. Type the URL command in the address bar. Press Enter.
3. The JPEG images will be displayed in your web browser.

http://192.168.5.151/video2.mjpg

NOTE
► Microsoft ® Internet Explorer does not support server push technology; therefore, using http://<ip
address>:<http port>/<access name for stream1 or stream2> will fail to access the Network Camera.

HTTPS

By default, the HTTPS port is set to 443. It can also be assigned to another port number between 1025
and 65535.

Two way audio

By default, the two way audio port is set to 5060. Also, it can also be assigned to another port number
between 1025 and 65535.
The Network Camera supports two way audio communication so that operators can transmit and receive
audio simultaneously. By using the Network Camera’s built-in or external microphone and an external
speaker, you can communicate with people around the Network Camera.
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Note that as JPEG only transmits a series of JPEG images to the client, to enable the two-way audio
function, make sure the video mode is set to “MPEG-4” on the Audio and Video Settings page and the
media option is set to “Video and Audio” on the Client Settings page. Please refer to Client Settings on
page 21 and Audio and Video Settings on page 53.

Audio transmitted to operators

America

Taiwan

Audio transmitted from operators

Audio is being transmitted to the Network Camera

Talk Button

Mic Volume

Mute

to enable audio transmission to the Network Camera; click
Click
to turn off the audio. To stop talking, click
again.
microphone; click

to adjust the volume of

FTP

The FTP server allows the user to save recorded video clips. You can utilize LevelOne Installation Wizard
2 to upgrade the firmware via FTP server. By default, the FTP port is set to 21. It also can be assigned to
another port number between 1025 and 65535.
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RTSP Streaming

To utilize RTSP streaming authentication, make sure that you have set a password for the Network
Camera first; please refer to Security on page 26 for details.

Authentication: Depending on your network security requirements, the Network Camera provides three
types of security settings for streaming via RTSP protocol: disable, basic, and digest.
If basic authentication is selected, the password is sent in plain text format, but there can be potential
risks of it being intercepted. If digest authentication is selected, user credentials are encrypted using
MD5 algorithm, thus providing better protection against unauthorized access.
The availability of the RTSP streaming for the three authentication modes is listed in the following table:
Disable
Basic
Digest

Quick Time player

Real Player

O
O
O

O
O
X

Access name for stream 1 / Access name for stream 2: This Network camera supports dual streams
simultaneously. The access name is used to differentiate the streaming source.
If you want to use an RTSP player to access the Network Camera, you have to set the video mode to
MPEG-4 and use the following RTSP URL command to request transmission of the streaming data.
rtsp://<ip address>:<rtsp port>/<access name for stream1 or stream2>
For example, when the access name for stream 1 is set to live.sdp:
1. Launch an RTSP player.
2. Choose File > Open URL. A URL dialog box will pop up.
3. Type the URL command in the text box. For example:
rtsp://192.168.5.151:554/live.sdp
4. The live video will be displayed in your player as shown
below.
Video 16:38:01 2008/01/03
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RTSP port /RTP port for video, audio/ RTCP port for video, audio
■ RTSP (Real-Time Streaming Protocol) controls the delivery of streaming media. By default, the port
number is set to 554.
■ The RTP (Real-time Transport Protocol) is used to deliver video and audio data to the clients. By
default, the RTP port for video is set to 5556 and the RTP port for audio is set to 5558.
■ The RTCP (Real-time Transport Control Protocol) allows the Network Camera to transmit the data by
monitoring Internet traffic volume. By default, the RTCP port for video is set to 5557 and the RTCP port
for audio is set to 5559.
The ports can be changed to values between 1025 and 65535. The RTP port must be an even number
and the RTCP port is the RTP port number plus one, and thus is always odd. When the RTP port
changes, the RTCP port will change accordingly.
If the RTP ports are incorrectly assigned, the following warning message will be displayed:

Multicast settings for stream 1 / Multicast settings for stream 2: Click the items to display the detailed
configuration information. Select the Always multicast option to enable multicast for stream 1 or stream 2.

Unicast video transmission delivers a stream through point-to-point transmission; multicast, on the other
hand, sends a stream to the multicast group address and allows multiple clients to acquire the stream at
the same time by requesting a copy from the multicast group address. Therefore, enabling multicast can
effectively save Internet bandwith.
The ports can be changed to values between 1025 and 65535. The multicast RTP port must be an even
number and the multicast RTCP port number is the multicast RTP port number plus one, and is thus
always odd. When the multicast RTP port changes, the multicast RTCP port will change accordingly.
If the multicast RTP video ports are incorrectly assigned, the following warning message will be
displayed:

Multicast TTL [1~255]: The multicast TTL (Time To Live) is the value that tells the router the range a
packet can be forwarded.
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DDNS
This section explains how to configure the dynamic domain name service for the Network
Camera. DDNS is a service that allows your Network Camera, especially when assigned with a
dynamic IP address, to have a fixed host and domain name.
DDNS: Dynamic domain name service

Enable DDNS: Select this option to enable the DDNS setting.
Provider: Select a DDNS provider of your choice from the Provider drop-down list. We offer other DDNS
providers, such as Dyndns.org(Dynamic), Dyndns.org(Custom), TZO.com, DHS.org, dyn-interfree.it.
Note that to utilize this feature, please apply a dynamic domain account first.

Refer to the following links to apply a dynamic domain account when selecting other DDNS
providers:

■ Dyndns.org (Dynamic) / Dyndns.org (Custom): visit http://www.dyndns.com/
■ TZO.com: visit http://www.tzo.com/
■ DHS.org: visit http://www.dhs.org/
■ dyn-interfree.it: visit http://dyn-interfree.it/
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Access List

Advanced Mode

This section explains how to control access permission by verifying the client PC’s IP address.
General Settings

Maximum number of concurrent streaming connection(s) limited to: Simultaneous live viewing for 1~10
clients (including stream 1 and stream 2). The default value is 10. If you modify the value and click Save,
all current connections will be disconnected and automatically attempt to re-link (IE Explore or Quick
Time Player).
View Information: Click this button to display the connection status window showing a list of the current
connections. For example:
Connection status

IP address

Elapsed time

192.168.1.147

12:20:34

root

61.22.15.3

00:10:09

anonymous

192.168.3.25

45:00:34

greg

Refresh

Add to Deny List

User ID

Disconnect

■ IP address: Current connections to the Network Camera.
■ Elapsed time: How much time the client has been at the webpage.
■ User ID: If the administrator has set a password for the webpage, the clients have to enter a user name
and password to access the live video. The user name will be displayed in the User ID column. If the
administrator allows clients to link to the webpage without a user name and password, the User ID
column will be empty.
There are some situations which allow clients access to the live video without a user name and
password:
1. The administrator does not set up a root password. For more information about how to set up a root
password and manage user accounts, please refer to Security on page 26.
2. The administrator has set up a root password, but set RTSP Authentication to “disable“. For more
information about RTSP Authentication, please refer to RTSP Streaming on page 46.
3. The administrator has set up a root password, but allows anonymous viewing. For more information
about Allow Anonymous Viewing, please refer to Security on page 26.
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■ Refresh: Click this button to refresh all current connections.
■ Add to deny list: You can select entries from the Connection Status list and add them to the Deny List
to deny access. Please note that those checked connections will only be disconnected temporarily
and will automatically try to re-link again (IE Explore or Quick Time Player). If you want to enable the
denied list, please check Enable access list filtering and click Save in the first column.
■ Disconnect: If you want to break off the current connections, please select them and click this
button. Please note that those checked connections will only be disconnected temporarily and will
automatically try to re-link again (IE Explore or Quick Time Player).
Enable access list filtering: Check this item and click Save if you want to enable the access list filtering
function.

Filter

There are two lists for permission control: Allowed list and Denied list. Only those clients whose IP
addresses are on the Allowed list and not on the Denied list can access the Network Camera. Please
note that the IPv6 access list column will not be displayed unless you enable IPv6 on the Network page.
For more information about IPv6 Settings, please refer to page 37 for detailed information.

■ Add a rule to Allowed/Denied list: Click Add to add a rule to Allowed/Denied list.
There are three types of rules for user to set up:
Single: This rule allows the user to add an IP address to the Allowed/Denied list.
For example:
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Network: This rule allows the user to assign a network address and corresponding subnet mask to the
Allow/Deny List.
For example:

IP address 192.168.2.x will be bolcked.
Range: This rule allows the user to assign a range of IP addresses to the Allow/Deny List. This rule is
only applied to IPv4.
For example:

■ Delete Allowed/Denied list:
In the Delete Allowed List or Delete Denied List column, make a selection and click Delete.

NOTE
► For example, when the range of IP addresses in the allowed list is set from 1.1.1.0 to 192.255.255.255
and the range in the denied list is set from 1.1.1.0 to 170.255.255.255, only users’ IP located between
171.0.0.0 and 192.255.255.255 can access the Network Camera.

Allowed
List

Denied
List

Administrator IP address

Always allow the IP address to access this device: You can check this item and add the Administrator’s
IP address in this field to make sure the Administrator can always connect to the device.
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Audio and Video
This section explains how to cofigure the audio and video settings of the Network Camera. It is
composed of the following two columns: Video Settings and Audio Settings.
Video Settings

Video title: Enter a name that will be displayed on the title bar of the live video.
Video Title
Title and Time

Video 10:23:18 2009/02/11

Color: Select to display color or black/white video streams.
Power line frequency: Set the power line frequency consistent with local utility settings to eliminate image
flickering associated with fluorescent lights. Note that after the power line frequency is changed, you
must disconnect and reconnect the power cord of the Network Camera in order for the new setting to
take effect.
Video orientation: Flip--vertically reflect the display of the live video; Mirror--horizontally reflect the display
of the live video. Select both options if the Network Camera is installed upside-down (ex. on the ceiling)
to correct the image orientation.
Overlay title and time stamp on video: Select this option to place the video title and time on the video
streams.
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Note that when the frame size is set to 176 x 144 as shown in the picture below, only the time will be
stamped on the video streams.

10:23:18 2009/02/11

Image Settings Advanced Mode
Click Image Settings to open the Image Settings page. On this page, you can tune the White balance,
Brightness, Saturation, Contrast, and Sharpness settings for the video.

White balance: Adjust the value for the best color temperature.
■ Auto
The Network Camera automatically adjusts the color temperature of the light in response to different light
sources. The white balance setting defaults to Auto and works well in most situations.
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■ Keep current value
Follow the steps below to manually set the white balance to compensate for the ambient lighting
conditions.
1. Set the White balance to Auto and click Save.
2. Place a sheet of white paper in front of the lens, then allow the Network Camera to adjust the color
temperature automatically.
3. Select Keep Current Value to confirm the setting while the white balance is being measured.
4. Click Save to enable the new setting.
Image Adjustment
■ Brightness: Adjust the image brightness level, which ranges from -5 to +5. The default value is set to 0.
■ Saturation: Adjust the image saturation level, which ranges from -5 to +5. The default value is set to 0.
■ Contrast: Adjust the image contrast level, which ranges from -5 to +5. The default value is set to 0.
■ Sharpness: Adjust the image sharpness level, which ranges from -3 to +3. The default value is set to +3.
You can click Preview to fine-tune the image, or click Restore to recall the original settings without
incorporating the changes. When completed with the settings on this page, click Save to enable the
setting and click Close to exit the page.
Privacy Mask Advanced Mode
Click Privacy Mask to open the settings page. On this page, you can block out sensitive zones to
address privacy concerns.

■ To set the privacy mask windows, follow the steps below:
1. Select Enable privacy mask to enable this function.
2. Click on the video window or use camera control buttons (Up, Down, Left, Right, Home, Zoom in/out,
and Go to) to move the desired position to the center.
3. Use the mouse to size and drag-drop the window, which is recommended to be at least twice the size
of the object (height and width) you want to cover.
4. Enter a Window Name and click Add. The name of privacy mask will be displayed on the Privacy
Mask list.
5. If you want to set up more privacy masks, please repeat above steps. Up to 8 privacy mask windows
can be set up, and only 4 windows can be displayed on the same screen.
6. Choose one color to apply to all privacy mask windows.
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■ To modify the privacy mask windows, follow the steps below:
1. Choose one of the privacy mask windows on the list you want to modify.
2. Click Modify and set up new configurations.
3. If you want to delete a privacy mask window, select it on the list and click Delete.

NOTE
► If you want to use Go to, the preset positions should be set in advance. For detailed configurations,
please refer to the Preset Location on page 64.
Sensor Settings Advanced Mode
Click Sensor Settings to open the Sensor Settings page. On this page, you can set the maximum
exposure time, exposure level, BLC, WDR settings, day/night settings, and image stabilizer.

Sensor Setting 1:
For normal situations

Sensor Setting 2:
For special situations
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Exposure Settings
User can choose Auto, or manually set Shutter Priority, Iris Priority, AGC priority, and BLC.
Auto: Select the sensitivity of IR cut filter (Low, Medium, or High).
The Network Camera automatically adjusts the iris and gain in response to different environments.
Depending on ambient lighting conditions, select either to enable WDR or the back light compensation.
Enable WDR (Wide Dynamic Range): Select this option to enable the WDR function. With WDR, the
Network Camera can cope with very challenging lighting conditions by combining the dark and bright
parts of an image to generate a realistic image representative of what is seen with the human eye. Note
that if you select this function, Back light compensation and Enable image stabilizer will be disabled.
Shutter Priority: Select a proper maximum exposure time according to the light source of the
surroundings. The exposure times are selectable for the following durations: 1/30000 ~ 1/2 second.
Shorter exposure times result in less light.
Select this option to adjust the desired shutter speed and allow the Network Camera to select an
appropriate iris and gain to obtain the correct exposure. Adjust the shutter speed from 1/2 second
(slowest) to 1/30000 second (fastest).
Iris Priority: Select a proper F-number (F1.4 ~ F32) according to ambient light.
F-number = Focal length / Iris diameter (lens aperture)
The greater the F-number, the shorter the iris diameter, and thus the less light admitted to the sensor.
Therefore, smaller F-number would be recommended for low-light applications.
AGC Priority (Auto Gain Control): You can manually set the Max gain (0 dB ~ 30 dB).
Back Light Compensation: Select "ON" and set a level (-5 ~ 5) according to the ambient light.

Day/Night Settings
Switch to B/W in night mode
Select this to enable the Network Camera to automatically switch to B/W during night mode.
IR cut filter
With a removable IR-cut filter and built-in IR illuminators effective up to 15m, this Network Camera can
automatically remove the filter and turn on the IR illuminators to let IR light into the sensor during low
light conditions.
■ Auto
The Network Camera automatically removes the filter by judging the level of ambient light.
■ Day mode
In day mode, the Network Camera switches on the IR cut filter at all times to block infrared light from
reaching the sensor so that the colors will not be distorted.
■ Night mode
In night mode, the Network Camera switches off the IR cut filter at all times for the sensor to accept
infrared light, thus helping to improve low light sensitivity.
■ Schedule mode
The Network Camera switches between day mode and night mode based on a specified schedule.
Enter the start and end time for day mode. Note that the time format is [hh:mm] and is expressed in
24-hour clock time. By default, the start and end time of day mode are set to 07:00 and 18:00.
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EIS Settings
Select this function to increase the stability of a captured image. The electronic image stabilizer that
reduces the effect of camera vibrations caused by traffic or wind enables the Network Camera to deliver
clear, razor-sharp images of moving objects. Please note that enable EIS will disable the DSS (Digital
Slow Shutter).

When completed with the settings on this page, click Save to enable the settings and click Close to exit
the page.

If you want to configure another sensor setting for day/night/schedule mode, please click Profile to open
the Sensor Settings Profile Settings page as shown below.
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Please follow the steps beolw to setup a profile:
1. Check Enable this profile.
2. Select the applied mode: Day mode, Night mode, or schedule mode. Please manually enter a range of
time if you choose Schedule mode.
3. Configure Exposure Settings in the second column. Please refer to page 56 for detailed information.
4. Configure EIS Settings in the third column. Please refer to the last page for detailed information.
5. Click Save to enable the setting and click Close to exit the page.

Video quality settings for stream 1 / stream 2 Advanced Mode
The Network Camera offers two choices of video compression standards for real-time viewing: MPEG-4
and MJPEG.
Click the items to display the detailed configuration settings. You can set up two seperate streams for the
Network Camera for different viewing devices. For example, set a smaller frame size and lower bit rate
for remote viewing on mobile phones and a larger video size and a higher bit rate for live viewing on web
browsers.
If MPEG-4 mode is selected, the video is streamed via RTSP protocol.
There are four parameters provided in MPEG-4 mode which allow you to adjust the video performance:
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■ Frame size
Select the video size. Note that a larger frame size takes up more bandwidth. The frame sizes are
selectable in the following resolutions:

CIF
QCIF

NTSC
704 x 480
352 x 240
176 x 120

PAL
704 x 576
352 x 288
176 x 144

■ Maximum frame rate
This limits the maximum refresh frame rate per second. Set the frame rate higher for smoother video
quality.
If the power line frequency is set to 50Hz, the frame rates are selectable at 1fps, 2fps, 3fps, 5fps,
8fps, 10fps, 15fps, 20fps, and 25fps. If the power line frequency is set to 60Hz, the frame rates are
selectable at 1fps, 2fps, 3fps, 5fps, 8fps, 10fps, 15fps, 20fps, 25fps, and 30fps. You can also select
Customize and manually enter a value.
■ Intra frame period
Determine how often to plant an I frame. The shorter the duration, the more likely you will get better
video quality, but at the cost of higher network bandwidth consumption. Select the intra frame period
from the following durations: 1/4 second, 1/2 second, 1 second, 2 seconds, 3 seconds, and 4 seconds.
■ Video quality
A complex scene generally produces a larger file size, meaning that higher bandwidth will be needed
for data transmission. Therefore, if Constant bit rate is selected, the bandwidth utilization is fixed at
a selected level, resulting in mutable video quality performance. The bit rates are selectable at the
following rates: 20Kbps, 30Kbps, 40Kbps, 50Kbps, 64Kbps, 128Kbps, 256Kbps, 512Kbps, 768Kbps,
1Mbps, 2Mbps, 3Mbps, and 4Mbps. You can also select Customize and manually enter a value.
On the other hand, if Fixed quality is selected, all frames are transmitted with the same quality;
bandwidth utilization is therefore unpredictable. The video quality can be adjusted to the following
settings: Medium, Standard, Good, Detailed, and Excellent. You can also select Customize and
manually enter a value.
If JPEG mode is selected, the Network Camera continuously sends JPEG images to the client, producing
a moving effect similar to a filmstrip. Every single JPEG image transmitted guarantees the same image
quality, which in turn comes at the expense of variable bandwidth usage. Because the media contents
are a combination of JPEG images, no audio data is transmitted to the client.
There are three parameters provided in MJPEG mode to control the video performance:
■ Frame size
Select the video size. Note that a larger frame size takes up more bandwidth. The frame sizes are
selectable in the following resolutions:

CIF
QCIF

NTSC
704 x 480
352 x 240
176 x 120

PAL
704 x 576
352 x 288
176 x 144

■ Maximum frame rate
This limits the maximum refresh frame rate per second. Set the frame rate higher for smoother video
quality.
If the power line frequency is set to 50Hz, the frame rates are selectable at 1fps, 2fps, 3fps, 5fps,
8fps, 10fps, 15fps, 20fps, and 25fps. If the power line frequency is set to 60Hz, the frame rates are
selectable at 1fps, 2fps, 3fps, 5fps, 8fps, 10fps, 15fps, 20fps, 25fps, and 30fps. You can also select
Customize and manually enter a value.
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■ Video quality
The video quality can be adjusted to the following settings: Medium, Standard, Good, Detailed, and
Excellent. You can also select Customize and manually enter a value.

NOTE
► Video quality and fixed quality refers to the compression rate, so a lower value will produce higher
quality.

Audio Settings

Mute: Select this option to disable audio transmission from the Network Camera to all clients. Note that
if mute mode is turned on, no audio data will be transmitted even if audio transmission is enabled on the
Client Settings page. In that case, the following message is displayed:

External microphone input: Select the gain of the external audio input according to ambient conditions.
Adjust the gain from +21 db (most sensitive) ~ -33 db (least sensitive).
Audio type: Select audio codec AAC or GSM-AMR and the bit rate.
■ AAC provides good sound quality at the cost of higher bandwidth consumption. The bit rates are
selectable from: 16Kbps, 32Kbps, 48Kbps, 64Kbps, 96Kbps, and 128Kbps.
■ GSM-ARM is designed to optimize speech quality and requires less bandwidth. The bit rates are
selectable from: 4.75Kbps, 5.15Kbps, 5.90Kbps, 6.7Kbps, 7.4Kbps, 7.95Kbps, 10.2Kbps, and
12.2Kbps.
When completed with the settings on this page, click Save to enable the settings.
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Motion Detection
This section explains how to configure the Network Camera to enable motion detection. A total
of three motion detection windows can be configured.

Video(TCP-AV)

Motion Detection Setting 1:
For normal situations

Motion Detection Setting 2:
For special situations

Follow the steps below to enable motion detection:
1. Click New to add a new motion detection window.
2. In the Window Name text box, enter a name for the motion detection window.
■ To move and resize the window, drag and drop your mouse on the window.
■ To delete window, click X on the top right corner of the window.
3. Define the sensitivity to moving objects and the space ratio of all alerted pixels by moving the
Sensitivity and Percentage slider bar.
4. Click Save to enable the settings.
5. Select Enable motion detection to enable this function.

For example:
Video(TCP-AV)

The Percentage Indicator will rise or fall depending on the variation between sequential images. When
motions are detected by the Network Camera and are judged to exceed the defined threshold, the
red bar rises. Meanwhile, the motion detection window will be outlined in red. Photos or videos can be
captured instantly and configured to be sent to a remote server (Email, FTP) by utilizing this feature as a
trigger source. For more information on how to set an event, please refer to Application on page 70.
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A green bar indicates that even though motions have been detected, the event has not been triggered
because the image variations still fall under the defined threshold.

Percentage = 30%

If you want to configure other motion detection settings for day/night/schedule mode, please click Profile
to open the Motion Detection Profile Settings page as shown below. A total of three motion detection
windows can be configured on this page as well.
Video(TCP-AV)

Please follow the steps beolw to set up a profile:
1. Create a new motion detection window.
2. Check Enable this profile.
3. Select the applicable mode: Day mode, Night mode, or Schedule mode. Please manually enter a time
range if you choose Schedule mode.
4. Click Save to enable the settings and click Close to exit the page.
This motion detection window will also be displayed on the Event Settings page. You can go to
Application > Event Settings > Trigger to choose it as a trigger source. Please refer to page 71 for
detailed information.
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NOTE
► How does motion detection work?
A

C

B

D

There are two motion detection parameters: Sensitivity and Percentage. In the illustration above,
frame A and frame B are two sequential images. Pixel differences between the two frames are
detected and highlighted in gray (frame C) and will be compared with the sensitivity setting. Sensitivity
is a value that expresses the sensitivity to moving objects. Higher sensitivity settings are expected to
detect slight movements while smaller sensitivity settings will neglect them. When the sensitivity is set
to 70%, the Network Camera defines the pixels in the purple areas as “alerted pixels” (frame D).
Percentage is a value that expresses the proportion of “alerted pixels” to all pixels in the motion
detection window. In this case, 50% of pixels are identified as “alerted pixels”. When the percentage is
set to 30%, the motions are judged to exceed the defined threshold; therefore, the motion window will
be outlined in red.
For applications that require a high level of security management, it is suggested to use higher
sensitivity settings and smaller percentage values.
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Camera Control
This section explains how to control the Network Camera’s Pan/Tilt/Zoom/Focus operation via
the control panel and how to preset positions.
Preset Locations

On this page, you can preset positions for the Network Camerato go to directly or patrol. A total of 128
preset positions can be configured.
Please follow the steps below to preset a position:
1. Adjust the shooting area to a desired position using the buttons on the right side of the window.
2. Click Set as home or Default home to define your home position.
3. Enter a name for the preset position, which allows for up to forty characters. Click Add to enable the
settings. The preset positions will be displayed under the Preset Location list on the left-hand side.
4. To add additional preset positions, please repeat step 1~3.
5. To remove a preset position from the list, select it from the drop-down list and click Delete.
6. Click Save to enable the settings.

1 Functions are the same

as the Control Panel on
the home page

3

2
3
5

6
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Patrol Settings

You can select preset locations for the Network Camera to patrol.
Please follow the steps below to set up a patrol schedule:
1. Click a preset location on the list and click Select.
2. The selected preset locations will be displayed on the Selected locations list.
3. Set the Dwelling time for the preset location during auto patrol. The default value is 0 seconds. You
can also manually set a value and click Update.
4. Repeat step 1 and 3 to select additional preset locations.
5. If you want to delete a selected location, select it from the list and click Remove.
6. Select a location and click Up or Down to rearrange the patrol order.
7. Adjust the Auto pan/patrol speed. (1~5 seconds)
8. Click Save to enable the settings.

x01xE
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2

1

3
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8
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Digital Zoom

If you check this option and click the Save button, the digital zoom function of CCD module will be
enabled.

Return to Home Position while Idle

If you select this option, the Network Camera will automatically return to the home position after idling for
a specific time span. Please remember to click Save to enable the settings.

■ The Preset Locations will be displayed on the Home page:

■ Click Go to: The Network Camera will move to the preset location.
■ Click Patrol: The Network Camera will patrol among the selected preset positions continuously.
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Homepage Layout

Advanced Mode

This section explains how to set up your own customized homepage layout.
Preview

This column shows the settings of your homepage layout. You can manually select the background and
font colors in Theme Options, the third column on this page. The settings will automatically show up in
this Preview field. The following shows the homepage using the default settings:

Logo

Here you can change the logo at the top of your homepage.

Follow the steps below to upload a new logo:
1. Click Custom and the Browse field will appear.
2. Select a logo from your files.
3. Click Upload to replace the existing logo with a new one.
4. Enter a website link if necessary.
5. Click Save to enable the settings.
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Theme Options

Here you can change the color of your homepage layout. There are three types of preset patterns for you
to choose from. The new layout will simultaneously appear in the Preview filed. Click Save to enable the
settings.

Preset Patterns

Font Color of the Video
Title
Font color
Background Color of the
Control Area
Font Color of the Configuration Area
Background Color of the
Configuration Area
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Frame Color

LevelOne

■ Follow the steps below to set up the customed homepage:
1. Click Custom on the left column.
2. Click the field where you want to change the color on the right column.

Color Selector

Custom
Pattern
3. The palette window will pop up as shown below.

2

3

1

4

4. Drag the slider bar and click on the left square to select a desired color.
5. The selected color will show up in the corresponding fields and in the Preview column.
6. Click Save to enable the settings.
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Application

Advanced Mode

This section explains how to configure the Network Camera to react in response to particular
situations (event). A typical application is that when a motion is detected, the Network Camera
sends buffered images to a FTP server or e-mail address as notifications.
In the illustration on the right, an event can be triggered
Action
by many sources, such as motion detection or external Event Trigger
digital input devices. When an event is triggered, you ex. Motion Detection,
Digital Input,
can specify what type of action that will be performed. System Reboot
You can configure the Network Camera to send
Media
Server
(what to send)
(where to send)
snapshots or videos to your email address or FTP site.
ex. Snapshot, Video Clips,
System Log, Digital Output

Customized Script

ex. Email, FTP, HTTP Server,
Network Storage

This function allows you to upload a sample script (.xml file) to the webpage, which will save your time on
configuring the settings. Please note that there is a limited number of customized scripts you can upload;
if the current amount of customized scripts has reached the limit, an alert message will pop up. If you
need more information, please ask for LevelOne technical support.

Click to upload a file

Click to modify the
script online
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Event Settings

In the Event Settings column, click Add to open the Event Settings page. On this page, you can
arrange three elements -- Trigger, Schedule, and Action to set an event. A total of 3 event settings can be
configured.

Event name: Enter a name for the event setting.
Enable this event: Select this option to enable the event setting.
Priority: Select the relative importance of this event (High, Normal, or Low). Events with a higher priority
setting will be executed first.
Detect next event after
motion is detected.

seconds: Enter the duration in seconds to pause motion detection after a
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An event is an action initiated by a user-defined trigger source; it is the causal arrangement of the
following three elements: Trigger, Event Schedule, and Action.
Trigger
This is the cause or stimulus which defines when to trigger the Network Camera. The trigger source can
be configured to use the Network Camera’s built-in motion detection mechanism or external digital input
devices.
There are several choices of trigger sources as shown below. Select the item to display the detailed
configuration options.
■ Video motion detection
This option makes use of the built-in motion detection mechanism as a trigger source. To enable this
function, you need to configure a Motion Detection Window first. For more information, please refer to
Motion Detection on page 61 for details.

■ Periodically
This option allows the Network Camera to trigger periodically for every other defined minute. Up to 999
minutes are allowed.

■ Digital input
This option allows the Network Camera to use an external digital input device or sensor as a trigger
source. Depending on your application, there are many choices of digital input devices on the market
which helps to detect changes in temperature, vibration, sound and light, etc.
■ System boot
This option triggers the Network Camera when the power to the Network Camera is disconnected.
■ Recording notify
This option allows the Network Camera to trigger when the recording disk is full or when recording
starts to rewrite older data. If you want receive Recording notify message, please refer to page 81
for detailed information.
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Event Schedule
Specify the period for the event.

■ Select the days of the week.
■ Select the recording schedule in 24-hr time format.
Action
Define the actions to be performed by the Network Camera when a trigger is activated.

■ Trigger digital output for seconds
Select this option to turn on the external digital output device when a trigger is activated. Specify the
length of the trigger interval in the text box.
■ Move to preset location
Select this option, the Network Camera will move to the preset location when a trigger is activated.
Please setup the preset locations first. Please refer to Preset Locations on page 64 for detailed
information.

To set an event with recorded video or snapshots, it is necessary to configure the server and
media settings so that the Network Camera will know what action to take (such as which server
to send the media files to) when a trigger is activated.
■ Add Server / Add Media

Click Add Server to configure Server Settings. For more information, please refer to Server Settings
on page 76.
Click Add Media to configure Media Settings. For more information, please refer to Media Settings on
page 79.
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Here is an example of the Event Settings page:

When completed, click Save to enable the settings and click Close to exit Event Settings page. The new
event settings / server settings / media settings will appear in the event drop-down list on the Application
page.
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Here is an example of the Application page with an event setting:

When the Event Status is ON, once an event is triggered by motion detection, the Network Camera will
automatically send snapshots via e-mail.
If you want to stop the event trigger, you can click ON to turn it to OFF status or click Delete to remove
the event setting.
To remove a server setting from the list, select a server name from the drop-down list and click Delete.
Note that only when the server setting is not being applied to an event setting can it be deleted.
To remove a media setting from the list, select a media name from the drop-down list and click Delete.
Note that only when the media setting is not being applied to an event setting can it be deleted.
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Server Settings

Click Add Server on Event Settings page to open the Server Setting page. On this page, you can specify
where the notification messages are sent when a trigger is activated. A total of 5 server settings can be
configured.
Server name: Enter a name for the server setting.
Server Type
There are four choices of server types available: Email, FTP, HTTP, and Network storage. Select the item
to display the detailed configuration options. You can configure either one or all of them.
Email: Select to send the media files via email when a trigger is activated.

■ Sender email address: Enter the email address of the sender.
■ Recipient email address: Enter the email address of the recipient.
■ Server address: Enter the domain name or IP address of the email server.
■ User name: Enter the user name of the email account if necessary.
■ Password: Enter the password of the email account if necessary.
■ Server port: The default mail server port is set to 25. You can also manually set another port.
If your SMTP server requires a secure connection (SSL), check This server requires a secure
connection (SSL).
To verify if the email settings are correctly configured, click Test. The result will be shown in a pop-up
window. If successful, you will also receive an email indicating the result.

Click Save to enable the settings, then click Close to exit the page.
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FTP: Select to send the media files to an FTP server when a trigger is activated.

■ Server address: Enter the domain name or IP address of the FTP server.
■ Server port
By default, the FTP server port is set to 21. It can also be assigned to another port number between
1025 and 65535.
■ User name: Enter the login name of the FTP account.
■ Password: Enter the password of the FTP account.
■ Remote folder name
Enter the folder where the media file will be placed. If the folder name does not exist, the Network
Camera will create one on the FTP server.
■ Passive Mode
Most firewalls do not accept new connections initiated from external requests. If the FTP server
supports passive mode, select this option to enable passive mode FTP and allow data transmission to
pass through the firewall.
To verify if the FTP settings are correctly configured, click Test. The result will be shown in a pop-up
window as shown below. If successful, you will also receive a test.txt file on the FTP server.

Click Save to enable the settings, then click Close to exit the page.
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HTTP: Select to send the media files to an HTTP server when a trigger is activated.

■ URL: Enter the URL of the HTTP server.
■ User name: Enter the user name if necessary.
■ Password: Enter the password if necessary.
To verify if the HTTP settings are correctly configured, click Test. The result will be shown in a pop-up
window as below. If successful, you will receive a test.txt file on the HTTP server.

Click Save to enable the settings, then click Close to exit the page.
Network storage: Select to send the media files to a network storage location when a trigger is activated.
Please refer to Network Storage Setting on page 83 for details.
Click Save to enable the settings, then click Close to exit the page.
When completed, the new server settings will automatically be displayed on the Event Settings page.
For example:
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Media Settings

Click Add Media on the Event Settings page to open the Media Settings page. On this page, you can
specify the type of media that will be sent when a trigger is activated. A total of 5 media settings can be
configured.
Media name: Enter a name for the media setting.
Media Type
There are three choices of media types available: Snapshot, Video clip, and System log. Select the item
to display the detailed configuration options. You can configure either one or all of them.
Snapshot: Select to send snapshots when a trigger is activated.

■ Source: Select to take snapshots from stream 1 or stream 2.
■ Send pre-event images
The Network Camera has a buffer area; it temporarily holds data up to a certain limit. Enter a number
to decide how many images to capture before a trigger is activated. Up to 7 images can be generated.
■ Send post-event images
Enter a number to decide how many images to capture after a trigger is activated. Up to 7 images can
be generated.
For example, if both the Send pre-event images and Send post-event images are set to 7, a total of 15
images are generated after a trigger is activated.
1 pic.

2 pic.

3 pic.

4 pic.

5 pic.

6 pic.

7 pic.

8 pic.

9 pic.

10 pic.

11 pic. 10 pic.

12 pic. 13 pic.

14 pic.

15 pic.

Trigger Activation

■ File name prefix
Enter the text that will be appended to the front of the file name.
■ Add date and time suffix to the file name
Select this option to add a date/time suffix to the file name.
For example:
Snapshot_20080104_100341
File name preﬁx Date and time sufﬁx
The format is: YYYYMMDD_HHMMSS

Click Save to enable the settings, then click Close to exit the page.
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Video clip: Select to send video clips when a trigger is activated.

■ Source: Select to record video clips from stream 1 or stream 2.
■ Pre-event recording
The Network Camera has a buffer area; it temporarily holds data up to a certain limit. Enter a number
to decide the duration of recording before a trigger is activated. Up to 9 seconds can be set.
■ Maximum duration
Specify the maximum recording duration in seconds. Up to 10 seconds can be set.
For example, if pre-event recording is set to five seconds and the maximum duration is set to ten
seconds, the Network Camera continues to record for another 4 seconds after a trigger is activated.
1 sec.

2 sec.

3 sec.

4 sec.

5 sec.

6 sec.

7 sec.

8 sec.

9 sec.

Trigger Activation

■ Maximum file size
Specify the maximum file size allowed.
■ File name prefix
Enter the text that will appended to the front of the file name.
For example:
Video_20080104_100341

File name preﬁx Date and time sufﬁx
The format is: YYYYMMDD_HHMMSS

Click Save to enable the settings, then click Close to exit the page.
System log: Select to send a system log when a trigger is activated.
Click Save to enable the settings, then click Close to exit the page.
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Recording notify message: Select to send a recording notification message when a trigger is activated.
The following is an example of a recording notification message (.txt file), which shows a list of deleted
previously-recorded data due to cycle recording.

When completed, click Save to enable the settings and click Close to exit this page. The new media
settings will appear on the Event Settings page.
You can continue to select a server and media type for the event. Please go back to page 71 for detailed
information.

■ SD Test: Click to test your SD card. The system will display a message indicating success or failure. If
you want to use your SD card for local storage, please format it before use. Please refer to page 86 for
detailed information.
■ Create folders by date, time, and hour automatically: If you check this item, the system will generate
folders automatically by date.
■ View: Click this button to open a file list window. This function is only for SD card and Network
Storage.
If you click View button of SD card, a Local storage page will pop up for you to manage recorded files
on the SD card. For more information about Local storage, please refer to page 86 for illustration.
If you click View button of Network storage, a file directory window will pop up for you to view
recorded data on the network storage. For detailed illustration, please refer to next page.
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The following is an example of a file destination with video clips:
20081120
20081121

The format is: YYYYMMDD
Click to open the directory

20081122

Click to delete all recorded data

Click to delete selected items

Click 20081120 to open the directory:
The format is: HH (24r)
Click to open the file list for that hour

Click to go back to the previous
level of the directory

Click to delete
selected items
Click to delete all
recorded data

The format is: File name prefix + Minute (mm)
You can set up the file name prefix on Media Settings page.
Please refer to page 79 for detailed information.
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Recording

Advanced Mode

This section explains how to configure the recording settings for the Network Camera.
Recording Settings

Insert your SD card and click here to test

NOTE
► Before setting up this page, please set up the Network Storage on the Server Settings page first.
► Please remember to format your SD card when using for the first time. Please refer to Local Storage
on page 95 for detailed information.
Network Storage Setting
Click Server to open the Server Settings page and follow the steps below to set up:
1. Fill in the information for your server.
For example:

3

Network storage path
(\\server name or IP address\folder name)

1

levelone
abc

2

4

User name and password for your server

2. Click Test to check the setting. The result will be shown in the pop-up window.
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If successful, you will receive a test.txt file on the network storage server.

3. Enter a server name.
4. Click Save to complete the settings and click Close to exit the page.
Recording Settings
Click Add to open the recording setting page. On this page, you can define the recording source,
recording schedule and recording capacity. A total of 2 recording settings can be configured.

Recording name: Enter a name for the recording setting.
Enable this recording: Select this option to enable video recording.
Priority: Select the relative importance of the recording setting (High, Normal, and Low).
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Source: Select the recording source (stream 1 or stream 2).
Recording Schedule: Specify the recording duration.
■ Select the days of the week.
■ Select the recording start and end times in 24-hr time format.
Destination: You can select the SD card or network storage to store the recorded video files.
Capacity: You can choose either the “entire free space available” or “limit the recording size”. The
recording size limit must be larger than the reserved amount for cyclic recording.
File name prefix: Enter the text that will be appended to the front of the file name.
Enable cyclic recording: If you check this item, when the maximum capacity is reached, the oldest file
will be overwritten by the latest one. The reserved amount is reserved for cyclic recording to prevent
malfunction. This value must be larger than 15 MBytes.
If you want to enable recording notification, please click Application to set up. Please refer to Trigger >
Recording notify on page 72 for detailed information.
When completed, select Enable this recording. Click Save to enable the setting and click Close to exit
this page. When the system begins recording, it will send the recorded files to the Network Storage.
The new recording name will appear in the drop-down list on the recording page as shown below.
To remove a recording setting from the list, select a recording name from the drop-down list and click
Delete.

■ Click Video (Name): Opens the Recording Settings page to modify.
■ Click ON (Status): The Status will become OFF and stop recording.
■ Click NAS (Destination): Opens the file list of recordings as shown below. For more information about
folder naming rule, please refer to page 82 for details.
20081120
20081121
20081122
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Local Storage

Advanced Mode

This section explains how to manage the local storage on the Network Camera. Here you can
view SD card status, search for recorded files to playback, download, etc.
no SD card

SD Card Management

SD card status: This column shows the status and reserved space of your SD card. Please remember to
format the SD card when using for the first time.
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SD card control
■ Enable cyclic storage: Check this item if you want to enable cyclic recording. When the maximum
capacity is reached, the oldest file will be overwritten by the latest one.

■ Enable automatic disk cleanup: Check this item and enter a day. If you enter “7 days”, the recorded
files will be stored on the SD card for 7 days.
Click Save to enable your settings.

Searching and Viewing the Records

This column allows the user to set up search criteria for recorded data. If you do not select any criteria
and click Search button, all recorded data will be listed in the Search Results cloumn.

File attributes: Select one or more items as your search criteria.
Trigger time: Manually enter the time range you want to search.
Click Search and the recorded data corresponding to the search criteria will be listed in Search Results
window.
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Search Results

The following is an example of search results. There are four columns: Trigger time, Media type, Trigger
type, and Locked. Click
to sort the search results in either direction.
Enter a key word to filter the
Numbers of entries displayed on one page
search results

Highlight an
item

Click to switch
pages

View: Click on a search result which will highlight the selected item in purple as shown above. Click the
View button and a media window will pop up to play back the selected file.
For example:

Click to adjust the image size
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Download: Click on a search result to highlight the selected item in purple as shown above. Then click
the Download button and a file download window will pop up for you to save the file.
JPEGs to AVI: This functions only applies to “JPEG“ format files such as snapshots. You can select
several snapshots from the list, then click this button. Those snapshots will be converted into an AVI file.
Lock/Unlock: Select the desired search results, then click this button. The selected items will become
Locked, which will not be deleted during cyclic recoroding. You can click again to unlock the selections.
For example:

Remove: Select the desired search results, then click this button to delete the files.
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System Log

Advanced Mode

This section explains how to configure the Network Camera to send the system log to the
remote server as backup.
Remote Log

You can configure the Network Camera to send the system log file to a remote server as a log backup.
Before utilizing this feature, it is suggested that the user install a log-recording tool to receive system log
messages from the Network Camera. An example is Kiwi Syslog Daemon. Visit http://www.kiwisyslog.
com/kiwi-syslog-daemon-overview/.

Follow the steps below to set up the remote log:
1. In the IP address text box, enter the IP address of the remote server.
2. In the port text box, enter the port number of the remote server.
3. When completed, select Enable remote log and click Save to enable the setting.

Current Log

This column displays the system log in chronological order. The system log is stored in the Network
Camera’s buffer area and will be overwritten when reaching a maximum limit.
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View Parameters

Advanced Mode

The View Parameters page lists the entire system’s parameters in alphabetical order. If you
need technical assistance, please provide the information listed on this page.
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Maintenance
This chapter explains how to restore the Network Camera to factory default, upgrade firmware
version, etc.
Reboot

This feature allows you to reboot the Network Camera, which takes about one minute to complete. When
completed, the live video page will be displayed in your browser. The following message will be displayed
during the rebooting process.

If the connection fails after rebooting, manually enter the IP address of the Network Camera in the
address field to resume the connection.

Restore

This feature allows you to restore the Network Camera to factory default settings.
Network Type: Select this option to retain the Network Type settings. (Please refer to Network Type on
page 33.)
Daylight Saving Time: Select this option to retain the Daylight Saving Time settings. (Please refer to
System on page 24.)
Custom Language: Select this option to retain the Custom Language settings.
If none of the options is selected, all settings will be restored to factory default.
The following message is displayed during the restoring process.

Calibrate

This feature re-calibrate the home position to the default center to recover the any displacement caused
by external forces. Please note that there is no confirm message box after clicking on Calibrate, and the
Network Camera will calibrate immediately.
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Export / Upload Files Advanced Mode
This feature allows you to Export / Upload daylight saving time rules, custom language files, and setting
backup files.

Export daylight saving time configuration file: Click to set the start and end time of DST.
Follow the steps below to export:
1. In the Export files column, click Export to export the daylight saving time configuration file from the
Network Camera.
2. A file download dialog will pop up as shown below. Click Open to review the XML file or click Save to
store the file for editing.

3. Open the file with Microsoft® Notepad and locate your time zone; set the start and end time of DST.
When completed, save the file.
In the example below, DST begins each year at 2:00 a.m. on the second Sunday in March and ends at
2:00 a.m. on the first Sunday in November.

User Manual - 93

LevelOne

Upload daylight saving time rule: Click Browse… and specify the XML file to upload.
If the incorrect date and time are assigned, you will see the following warning message when uploading
the file to the Network Camera.

The following message is displayed when attempting to upload an incorrect file format.

Export language file: Click to export language strings. LevelOne provides nine languages: English,
Deutsch, Español, Français, Italiano, 日本語, Português, 簡体中文, and 繁體中文.
Upload custom language file: Click Browse… and specify your own custom language file to upload.
Export setting backup file: Click to export all parameters for the device and user-defined scripts.
Upload setting backup file: Click Browse… to upload a setting backup file. Please note that the model
and firmware version of the device should be the same as the setting backup file. If you have set up a
fixed IP or other special settings for your device, it is not suggested to upload a settings backup file.

Upgrade Firmware

This feature allows you to upgrade the firmware of your Network Camera. It takes a few minutes to
complete the process.
Note: Do do not power off the Network Camera during the upgrade!
Follow the steps below to upgrade the firmware:
1. Download the latest firmware file from the LevelOne website. The file is in .pkg file format.
2. Click Browse… and specify the firmware file.
3. Click Upgrade. The Network Camera starts to upgrade and will reboot automatically when the upgrade
completes.
If the upgrade is successful, you will see “Reboot system now!! This connection will close”. After that, reaccess the Network Camera.
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The following message is displayed when the upgrade has succeeded.
Reboot system now!!
This connection will close.

The following message is displayed when you have selected an incorrect firmware file.
Starting firmware upgrade...
Do not power down the server during the upgrade.
The server will restart automatically after the upgrade is
completed.
This will take about 1 - 5 minutes.
Wrong PKG file format
Unpack fail
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Appendix

URL Commands for the Network Camera
Overview
For some customers who already have their own web site or web control application, the Network
Camera/Video Server can be easily integrated through URL syntax. This section specifies the external
HTTP-based application programming interface. The HTTP-based camera interface provides the
functionality to request a single image, control camera functions (PTZ, output relay etc.), and get and set
internal parameter values. The image and CGI-requests are handled by the built-in Web server.

Style Convention
In URL syntax and in descriptions of CGI parameters, text within angle brackets denotes content that
is to be replaced with either a value or a string. When replacing the text string, the angle brackets
should also be replaced. An example of this is the description of the name for the server, denoted with
<servername> in the URL syntax description below, that is replaced with the string myserver in the URL
syntax example further down in the page.
URL syntax is denoted with the word "Syntax:" written in bold face followed by a box with the referenced
syntax as shown below. For example, name of the server is written as <servername> and is intended to
be replaced with the name of the actual server. This can either be a name, e.g., "mywebcam" or "thecam.
adomain.net" or the associated IP number for the server, e.g., 192.168.0.220.
Syntax:
http://<servername>/cgi-bin/viewer/video.jpg

Description of returned data is written with "Return:" in bold face followed by the returned data in a box. All data
returned as HTTP formatted, i.e., starting with the string HTTP is line separated with a Carriage Return and Line
Feed (CRLF) printed as \r\n.
Return:
HTTP/1.0 <HTTP code> <HTTP text>\r\n

URL syntax examples are written with "Example:" in bold face followed by a short description and a light grey box
with the example.
Example: request a single snapshot image
http://mywebserver/cgi-bin/viewer/video.jpg
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http://mywebserver/cgi-bin/dido/setdo.cgi?do1=1
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<group>_<name>





update
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do<num>






return









http://myserver/cgi-bin/dido/setdo.cgi?do1=
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http://myserver/cgi-bin/dido/getdi.cgi?di1
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http://myserver/cgi-bin/dido/getdo.cgi?do1










 






 








channel







resolution







quality
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http://<servername>/cgi-bin/admin/editaccount.cgi
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http://<servername>/cgi-bin/admin/syslog.cgi
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http://<servername>/cgi-bin/admin/upgrade.cgi
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Please embrace your input value with single quotes.
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Technology License Notice
MPEG-4 AAC Technology
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 AAC AUDIO PATENT LICENSE. THIS PRODUCT MAY
NOT BE DECOMPILED, REVERSE-ENGINEERED OR COPIED, EXCEPT WITH REGARD TO PC SOFTWARE,
OF WHICH YOU MAY MAKE SINGLE COPIES FOR ARCHIVAL PURPOSES. FOR MORE INFORMATION,
PLEASE REFER TO HTTP://WWW.VIALICENSING.COM.

MPEG-4 Visual Technology
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE FOR THE
PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING VIDEO IN COMPLIANCE
WITH THE MPEG-4 VISUAL STANDARD ("MPEG-4 VIDEO") AND/OR (ii) DECODING MPEG-4 VIDEO THAT
WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL AND NON-COMMERCIAL ACTIVITY AND/
OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSED BY MPEG LA TO PROVIDE MPEG-4 VIDEO.
NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION
INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL AND COMMERCIAL USES AND LICENSING MAY
BE OBTAINED FROM MPEG LA, LLC. PLEASE REFER TO HTTP://WWW.MPEGLA.COM.

AMR-NB Standard
THIS PRODUCT IS LICENSED UNDER THE AMR-NB STANDARD PATENT LICENSE AGREEMENT. WITH
RESPECT TO THE USE OF THIS PRODUCT, THE FOLLOWING LICENSORS’ PATENTS MAY APPLY:
TELEFONAKIEBOLAGET ERICSSON AB: US PAT. 6192335; 6275798; 6029125; 6424938; 6058359. NOKIA
CORPORATION: US PAT. 5946651; 6199035. VOICEAGE CORPORATION: AT PAT. 0516621; BE PAT. 0516621;
CA PAT. 2010830; CH PAT. 0516621; DE PAT. 0516621; DK PAT. 0516621; ES PAT. 0516621; FR PAT. 0516621;
GB PAT. 0516621; GR PAT. 0516621; IT PAT. 0516621; LI PAT. 0516621; LU PAT. 0516621; NL PAT. 0516621;
SE PAT 0516621; US PAT 5444816; AT PAT. 819303/AT E 198805T1; AU PAT. 697256; BE PAT. 819303; BR PAT.
9604838-7; CA PAT. 2216315; CH PAT. 819303; CN PAT. ZL96193827.7; DE PAT. 819303/DE69611607T2; DK
PAT. 819303; ES PAT. 819303; EP PAT. 819303; FR PAT. 819303; GB PAT. 819303; IT PAT. 819303; JP PAT. APP.
8-529817; NL PAT. 819303; SE PAT. 819303; US PAT. 5664053. THE LIST MAY BE UPDATED FROM TIME TO
TIME BY LICENSORS AND A CURRENT VERSION OF WHICH IS AVAILABLE ON LICENSOR’S WEBSITE AT
HTTP://WWW.VOICEAGE.COM.
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Electromagnetic Compatibility (EMC)
FCC Statement
This device compiles with FCC Rules Part 15. Operation is subject to the following two conditions.
■ This device may not cause harmful interference, and
■ This device must accept any interference received, including interference that may cause undesired
operation.
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance
with the installation manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference, in which case the user will be
required to correct the interference at his own expense.

CE Mark Warning
This is a Class A product. In a domestic environment, this product may cause radio interference, in which
case the user may be required to take adequate measures.

Liability
LevelOne Inc. cannot be held responsible for any technical or typographical errors and reserves the right
to make changes to the product and manuals without prior notice. LevelOne Inc. makes no warranty
of any kind with regard to the material contained within this document, including, but not limited to, the
implied warranties of merchantability and fitness for any particular purpose.
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